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About This Document
This document is a guide for the just:play user. It contains all necessary information on how to use the 
just:play user interface. We make these assumptions:

ρρ You are familiar with the Macintosh environment.
ρρ The just:play system has been properly configured by your system administrator.
ρρ The system has been properly tested and no errors have occurred during the testing period.
ρρ After reading this document the user understands how to use just:play.
ρρ The user is aware of the third party hard- and software used with the same system.
ρρ The user knows how his particular channel is configured and how to use the specific functions.
ρρ The user knows how to react if a problem occurs, has access to the support system and knows how 

to report a bug or feature request.

1  About the just:play Interface 
The just:play graphical user interface (also called "just:play UI") represents a simple way to build a rundown 
with QuickTime video clips, live video events, graphic events (such as inserts, tickers or information 
templates) and router/GPI events – directly connected to the active engine. just:play integrates video 
playout with static or dynamic realtime graphics combined with on- or offline scheduling. 

The just:play UI connects directly to a channel (which has been configured by your system administrator 
in just:connect before), allowing direct and last minute changes when connected to an online channel. 
It is possible to connect to a channel which is offline to build playlists and rundowns and save them to 
an online channel. In any step of the scheduling process the user can control planning.

just:play is the part of software where a user can create, edit, structure and import playlists. A playlist 
– which contains video clips, graphic elements and events – can be planned and executed weeks in 
advance which allows a completely unattended remote operation.

just:connect allows an unlimited number of just:play UIs to connect to the same channel for concurrent 
schedule manipulation on a first come first serve base. The users are only limited by the user rights 
defined for each user in just:connect.
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2  just:play User Interface
just:play User Interface

Connecting to a Channel2.1 

Before using just:play it is required to connect to a channel. 
After opening just:play the first dialog prompts the user to 
connect to a channel. Choose a channel here and log in with 
the appropriate user/password combination.

Click "Connect" to start the just:play UI with the selected 
channel activated.

Note

You will get a warning if access is denied. If you see a message beginning with one of the 
following words please contact your system administrator.
ρρ Message 1: Sorry, User…
ρρ Message 2: Sorry, Interface Client…
ρρ Message 3: This channel is only for use with just:live!

just:play User Interface

Managing Channel Connections2.2 

By clicking on the sprocket icon you can flip the login window. 
Here you can define fixed hosts to which you may want to 
connect. 

This kind of setup should have been done by your system 
administrator. Please contact your administrator before 
making any changes.
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just:play User Interface

Control Area2.3 

Once the just:play UI has been started it will gather the channel information from just:connect and 
present the information through the user interface to you. In the upper middle of the just:play UI you 
see the control area. Following information is presented here:

If you are connecting to an online channel the "Master Time" 
will appear in green color. Switching to "Editing Mode" is 
described later in this document. 

If you are connecting to an offline channel the "Master Time" 
will appear in yellow color.

On the right side (below the timecode) you can see the name of the channel you are currently connected 
to. At any time you can switch to another channel: Click on the channel's name drop-down menu and 
select another channel which is in the same network area. Switching to another channel means that the 
whole interface will change to reflect the status of the other channel. If you try to connect to a channel 
with insufficient permissions you will get a warning. Please contact your system administrator for more 
information.

"Connected to: (Online)"
This channel is online which means that an active just:out is 
playing out the content which is scheduled at the moment.

"Connected to: (Offline)"
This channel is offline which means that there is no active 
just:out connected to this channel. Therefore any change 
made in the rundown must be saved to an active channel 
before it takes effect.

When connected to an online channel the buffer area is 
showing a red to green gradient which represents the buffer 
state. When connected to an offline channel the bar is empty.
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just:play User Interface

Preferences2.4 

The actual setup and configuration of a channel is done in just:connect by your system administrator. 
The whole channel is defined there (including the number of activated layers, whether one of the layers 
is used for the station ID ("bug") and the user permissions for a particular channel). But there are also 
some settings which are related to the just:play UI installed on a particular machine. To configure a 
copy of just:play, open the preferences dialog in the menu "Just Play » Preferences".

1

3

5

2

4

1 Tooltips
Deactivate this option to disable tooltips in the library while moving the mouse pointer over ele
ments. This option is enabled by default.

2 Poster Frames Cache
This defines the folder where poster frames will be saved. By default the poster frames are saved 
in the folder "Poster Frames" inside of the "Documents" folder of the current user. This option is 
enabled by default. Disable it to suppress the creation of new poster frames in the workbench of 
just:play.

3 Default Video In-Point
This option is disabled by default. Enable it to enter a timecode value. Once enabled the in-
point of QuickTime movies which are dragged from the library into a playlist will be set to the 
specified value (assuming that the QuickTime movie contains timecode). This is useful if all of 
your QuickTime movies contain a trailer or countdown before the actual video content starts.

4 Reset all dialog warnings
Pressing the "Reset" button enables dialog warnings again.

5 Automatically refresh dropped playlists
Activating this feature automatically "refreshes" any playlists when they are dragged from the 
"Playlists" tab (in the library) and dropped into either the calendar or the workbench view. This 
is useful especially when you have older saved playlists which do not include the necessary 
metadata for using the aspect ratio features and you want to automatically include them when 
dropping playlists into the schedule. 

Depending on the size of the playlist (= the number of video clips) this feature may slow down 
dropping playlists into the schedule as each video clip in the playlist has to be interpreted by 
just:play and the necessary metadata needs to be extracted.
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just:play User Interface

Overview2.5 

Control Area

Timeline

Library Calendar
View

Workbench Inspector

1

2

3

4

5
6

1 Control Area
Shows the poster frame of the current and next item, including the related information about the 
elapsed and remaining time, general warnings and the buffer status.

2 Timeline
Layers and timecodes allow positioning of QuickTime movies, graphic elements and events 
(router controls and GPI triggers). The layer visibility is defined from top to down.

3 Library
Divided in four tabs the library shows QuickTime movies, graphic elements, events and saved 
playlists. Related metadata will also be shown (if available). A preview window and a search field 
complement the library.

4 Calendar View
Gives an overview of the whole rundown by showing the scheduled playlists. Jump back and 
forth by a full day using the arrows or the built-in calendar.

5 Workbench
Shows the content of the selected playlist depending on the layer selection made in the timeline.

6 Inspector
Here you can modify attributes of one or more selected elements.
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just:play User Interface

Active Channel Modes2.6 

Once you open just:play and connect to an active channel the timecode display shows the engine time. 
There are two modes in just:play: "Master Time Mode" and "Editing Mode". They are explained in the 
following two chapters.

After connecting to a channel just:play starts in "Master Time Mode". You can switch from "Master 
Time Mode" into "Editing Mode" by dragging the timeline's ruler or by double clicking an element in the 
calendar view, workbench or timeline. Changing the day in the calendar view will also activate "Editing 
Mode".

just:play User Interface

Master Time Mode2.7 

Use the "Master Time Mode" to control the current playout. The 
timecode is green and synchronized with the engine's time, 
which means that the UI reflects the current playout position.

In "Master Time Mode", dragging items within the timeline and altering the duration of graphic elements 
within the timeline is not possible. Nevertheless it is possible to change the attributes of any item in 
the inspector as long as it isn't in the past. You can also edit the rundown in the workbench area by 
dragging and dropping elements (to add/delete elements or to change their position).

just:play User Interface

Editing Mode2.8 

To edit clips directly in the timeline you must drag the timeline's ruler to break the sync with the engine's 
time (or double click on the item you want to edit) which brings just:play into "Editing Mode".

Use the "Editing Mode" to preview the playout of your videos 
and to change the position and the length of elements in a FX 
layer.

Scrubbing through Video Clips
To preview videos, drag and scrub timeline ruler to watch a 
frame by frame preview in the "On Air" window. 
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Changing the Position of Elements in the Timeline
To change the position of an element in the timeline, simply 
drag and drop it within the playlist in the timeline.

Changing the Duration of a Graphic Element
In "Editing Mode" you can also change the length of a graphic 
element (which has at least one stop frame) by moving the 
mouse pointer to the beginning/end of the graphic element 
and drag the start/endpoint. Doing so the mouse will snap to 
the start/endpoints of elements in the video layer.

Switching back to "Master Time Mode"
To switch back from "Editing Mode" into "Master Time Mode" 
click on the "Now" button once. 

Note

It is not possible to preview elements in the FX layers because those elements are gene
rated in realtime once they are playing out.



address Zirkusgasse 39 | A-1020 Vienna | Austria | phone +43 (0) 1 236 8665 | mail info@toolsonair.com | website www.toolsonair.com 8tools ‡ air

just:play User Interface

Control Area2.9 

1 2 3

65 74

1 "On Air" Preview

In "Master Time Mode"
Displays the poster frame of the upcoming 
element of the selected layer.

In "Editing Mode"
Displays the frame of the CTI position after 
double clicking on an element or while scrub
bing in the timeline.

2 Current Timecode
Displays timecode with additional information. Click on the timecode to toggle between three 
modes.
ρρ Mode 1: "Master Time Mode" or "Editing Mode" CTI position
ρρ Mode 2: "Next Live Event In" – This timecode shows the remaining time to the next live event 

in relation to the current position of the CTI.
ρρ Mode 3: "Next Sync Point In" – This timecode shows the remaining time to the next sync point 

defined in the rundown in relation to the current position of the CTI.

Above the timecode the sync point information will be shown if there is a sync point defined 
within the next 24 hours. Below the timecode the name of the currently selected channel is shown 
with the ability to switch from one to another channel.

3 "Next" Preview
Displays the poster frame of the upcoming element of the selected layer.

4 "Now" Button
This button is only available while working in "Editing Mode". Click on this button to leave "Editing 
Mode" and to synchronize the timeline, the calendar view and the workbench with the current 
playout position

5 Engine Buffer Status
The buffer should always stay in the green range. If the buffer reaches the red range the playout 
may drop frames. This can be caused by complex graphics but also by slow disk drives and 
general low system performance (e.g. wrong system components like unsupported graphics 
cards). Depending on the setting your system administrator made, the buffer is between six 
frames and three seconds.
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6 "Next" Button
This button can be used to jump to the next QuickTime movie. In this case the currently playing 
video is "shortened" (its out point is set to the current playout time when the button is clicked) 
and the next movie in the playlist will be started immediately. All graphics (except the one on the 
infinite layer) playing at this moment, as well as all graphics starting later on the same clip will 
be cleared/not played. Note that – as with the infinite length live video input clip – any following 
items and playlists will be rescheduled for an earlier start time. Any timed and chained playlists 
will also be rescheduled.

7 Warnings
The system examines the playlists four hours ahead for faults like gaps between two playlists 
and overlaps as well as gaps at the end of a playlist. A warning referring to the first problem in 
your rundown will be shown. The warning also contains the time point when the problem occurs.
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just:play User Interface

Timeline2.10 

1

8

2 3 4 5 6 7

1 Layers
From top to bottom: The first layer is the "Playlist" layer followed by the "FX" layers and the "Video" 
layer (the names of the layers have been defined by your system administrator while setting 
up the channels in just:connect). Clicking a layer selects it. Notice that only the content of the 
selected layer is visible in the workbench. Also the preview and coming next information in the 
control area depend on the layer selection. The currently selected layer is highlighted in blue.

2 Elapsed Timecode
Displays the elapsed time for each actual playing element. If a layer does not contain any elements 
the timecode is zero.

3 Name of the Element
Displays the name of the element in the particular layer.

4 Timeline View
Displays QuickTime movies, live events, graphic elements and router control/GPI triggers in a 
similar fashion to common video editing systems like Final Cut Pro. Gaps within a playlist with an 
empty video layer are highlighted for better recognition.

5 Name of the upcoming Element
Displays the name of the upcoming element of the particular layer.

6 Remaining Timecode
Displays the remaining time for each actual playing element.

7 Hide/Show Buttons
These buttons enable or disable the visibility of the currently playing element of the specific layer.

8 Timeline Scrub & Scale
Scrub through time by dragging the scroll bar or the ruler. Set the scale of the timeline view by 
using your mouse wheel or by moving the ruler up/down. You can always relocate the CTI by 
pressing the "Now" button.
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just:play User Interface

Timeline (Detail)2.11 

2 43 51

6 7 8

1 Current Time Indicator (CTI)
Indicates the current position. While watching the current playout position ("Master Time Mode") 
the CTI is always green. In "Editing Mode" you will see the green CTI representing the real playout 
position and the white CTI representing the current preview position.

2 Playlist Name
The name of a playlist, which can be changed in the inspector.

3 Router Control/GPI Events
Router and GPI events are represented by a yellow triangle.

4 Graphic Element
Graphic elements are represented by small grey bars. Such elements can be placed in one of the 
available FX Layers.

5 Video Element
Video elements are represented by larger grey bars in the "Video"-layer.

6 Video Gap
Gaps are those parts of a playlist where the playout will go to black (or switch to the live signal, 
depending on the configuration of your system administrator) because there are no elements 
scheduled yet. Gaps should be avoided. It is not possible to have a gap between two clips within 
a playlist. A gap can only be at the end of a playlist (after the last video). The "Default Gap Playlist" 
will only be used if there is a gap between two playlists.

7 Stopframe Triangle
Graphic elements can contain stopframes. They are represented by grey triangles. Changing the 
duration of a graphic element automatically changes the time it takes to release a stopframe.

8 Selected Element
A selected element is highlighted in blue (same for the workbench as seen later). Selecting allows 
you to modify the element in the inspector. Double clicking an element moves the editing CTI to 
the beginning of the element and allows you to modify some parameters directly in the timeline.
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just:play User Interface

Library2.12 

1 2 3 4

5

9

6 7 8

1 Video Tab
Lists QuickTime movie files from the repository folder(s). If a movie does not show up in the list 
(but in the Finder) check if the file ends with one of the supported suffixes: mov, mpg, mpeg, 
m4v, f4v, dv or mxf. Only files with a supported suffix are shown in the library. just:play displays 
any "avi" and "mov" files in the library. Please note that you must ensure that the correct codecs 
are installed to decode the material stored in an avi- or mov container file. Contact your system 
administrator for more information.

2 Graphic Tab
Lists graphic files from the repository folder(s).

3 Event Tab
Lists event elements like live video input and router control.

4 Playlists Tab
Lists saved playlists. Playlists can be saved to reuse them for the same channel but also to use 
them on another machine. Build a playlist and select "Save Playlist As…" from the "File" menu 
to save it. You can also drop playlists from the calendar view into the playlist field. Final Cut Pro 
compliant XML files saved in the playlist folder will show up here for immediate use.

5 Metadata Columns
Depending on the selected tab you will see metadata columns. You can rearrange and change the 
width of the columns by moving the elements in the header area.

6 Search Field
Allows you to search for files in the repositories and for related metadata. Click on the magnifying 
glass to select the metadata column you want to use for the search.

7 Preview Area
Pressing the preview button shows or hides the preview area.
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8 Invert View Button
Click on this button to change the sorting order (from A…Z or from Z…A) of the selected tab.

9 Preview Button
Allows you to preview QuickTime movies and some graphic elements. Press the preview button 
to show or hide the preview area. You can use the mouse wheel to scrub through a movie. Under 
the "Events" tab the preview button changes its functionality as well as the icon. In this case 
clicking the "+" button allows you to build a new router control/GPI event.

Notes

ρρ You can navigate the library like a Finder window (in list view) by using the arrow keys. 
You can preview QuickTime movies by pressing the space bar. To get information 
about a movie, place the mouse over it and wait for a moment.

ρρ You can hide/show as well as dock/undock the library using the corresponding menu 
options under the "View" menu.
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just:play User Interface

Calendar View2.13 

2

1

3

4

65

1 Day View
Displays the currently selected day.

2 CTI(s)
Same as in the timeline. Either you have one CTI ("Master Time Mode") or two CTIs ("Editing 
Mode").

3 Playlist
Create a playlist by click drag or double click in the calendar view. Move playlists by dragging 
them, delete them with the backspace/delete key. Double clicking a playlist moves the CTI to the 
beginning of the playlist. Doing so will immediately activate "Editing Mode".

4 00:00 Timepoint
Indicates the end of the current day and the start of the next day.

5 Time Scale 
Represents a vertical timeline scale. You can drag the scrollbar to the left/right to rescale the time 
scale.

6 Calendar (with previous/next day arrows)
Opens a sliding window with a month/day view. This allows you to show/create schedules for 
different days. Click on the left/right arrow to easily go the a previous or next day. Doing so will 
immediately activate "Editing Mode".
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just:play User Interface

Workbench2.14 

1

2 5 6 8 11

1514

12

3 4 7 9 10

16
13

Note

You can select which columns will be shown in the workbench by using the corresponding 
menu options under the "View" menu. In addition you can rearrange and change the width 
of the columns by moving the elements in the header area.

1 Poster Column
Poster frames of elements.

2 Name Column
Names of playlists and elements.

3 Start Column
Start times of elements.

4 End Column
End times of elements.

5 Duration Column
Durations of elements.



address Zirkusgasse 39 | A-1020 Vienna | Austria | phone +43 (0) 1 236 8665 | mail info@toolsonair.com | website www.toolsonair.com 16tools ‡ air

6 Color Column
An element may have a color defined by selecting it in 
the inspector. The color for each item is also shown in 
a column in the workbench (if this column is enabled). 
When dragging and dropping items from the library, the 
"Finder" color (if defined) will automatically be set for the 
item and shown in the workbench.

7 Warnings Column
There are two different icons which can show up in this 
column. If the length of a QuickTime movie/live clip has 
been changed by clicking on the "Jump to Next Clip" button, 
a small warning symbol  will be shown. In addition to 
this the real length and the planned length is shown in the 
inspector – as seen in this screenshot. 

The sync point icon  is shown if there has been a sync 
point defined for this element. A sync point is a "wish start 
time", where the offset between the real start time and the 
wish start time is shown in the control area.

8 Codec Column
Here you can see the codec of the QuickTime movie with a color code which indicates the selected 
field order. In case the field order matches your engine's field order the codec is shown in white. If 
the field order has been changed to match the engine's field order it is shown in yellow and when 
the field order has been changed but does not match anymore it is shown in red.

9 Dimensions Column
Shows the pixel size of the element (how it will be shown on screen).

10 Aspect Column
This column shows the original aspect ratio of the QuickTime movie with a color code:

Yellow: Aspect ratio has been corrected to match the engine's aspect ratio.

White: The aspect ratio of the movie and the engine is the same.

Red: Aspect ratio has been changed and does not match the engine's aspect ratio anymore.

11 FPS Column
Shows the frames per second of a movie. Only fps which are supported by the engine will be visible 
here, movies with another frame rate will be rejected when being dropped into the workbench. 

12 Selected Element
A selected element is highlighted in blue (same for the timeline as seen before). Selected elements 
can be modified in the inspector. The name of a clip turns green (instead of white) when playing 
out. Double clicking an item within the workbench moves the CTI to the beginning of the clip in 
the timeline and will immediately activate "Editing Mode".
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13 Rundown
Shows the rundown of your clips playing from top to bottom, one clip after the other. Already 
played out clips are greyed out in the workbench. If you are in "Editing Mode" the workbench 
"simulates" the clips' states according to the CTI position. These are not the clips' states of the 
real playout. Remember that only those elements which are loaded in the layer selected in the 
timeline will be shown here. Select another layer in the timeline to see the elements loaded on that 
particular layer in the workbench.

14 Item Count
Shows the number of elements scheduled on the selected layer for the current day.

15 Single View
Shows only the content of the playlist currently selected in the calendar view.

16 Multi View
Shows the content of all playlists which have the start time during the currently selected day.

just:play User Interface

Inspector2.15 

1

3 4

2

1 Inspector
Shows the attributes of a selected element. You can click on the individual fields in the timecode 
editor inside the inspector to edit them. Either type the values or use the up/down arrow keys to 
increase/decrease the values. Use the left/right arrow keys to switch between values. Use the tab 
key to switch between fields.
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2 Selected Clip Preview
Shows a preview of the currently selected clip and allows you to the set the in-point visually.

3 Visual In/Out-Point Control
Clicking on this icon opens a preview window with a small timeline of the selected item. This 
allows to set the in- and out-point of a QuickTime movie using the mouse.

4 "Fast Access" Button
ρρ Playlist is selected: The button allows you to save the selected playlist.
ρρ Graphic is selected: The button allows you to reset all input ports (= reset all attributes to their 

default value).
ρρ QuickTime movie is selected: The button allows you to split the clip.
ρρ Still image is selected: The button is disabled.

Note

You can hide/show and dock/undock the inspector using the corresponding menu options 
under the "View" menu.
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just:play User Interface

Inspector: Standard Attributes, Video & Audio2.16 

1

2

3

4

5

1 Name: Name of the selected element.

Start: Start time of the selected element.

In/Out Point: Sets the in/out-point of a clip.

Duration: Shows the duration of the selected 
element depending on the defined in/out-point.

Over/Under: If the length of a clip has been 
changed by clicking on the "Jump to Next Clip" 
button the real length and the planned length is 
shown in this field.

Color: Sets the color of the selected element.

2 Fade In/Out: Movies can fade-in or out up to 10 
seconds from and to black.

Invert Fields: If enabled fields are inverted. This 
can also be changed during playout of the selected 
clip and will be executed immediately (depending 
on the video buffer your system administrator set 
in the just:out preferences).

Aspect Conversion: Defines how to handle the 
aspect ratio of the selected QuickTime movie. 
Your system administrator should already have 
a setting predefined in the just:out preferences. 
Several options are available depending on the 
direction of the conversion. For a visual description 
please refer to the chapter "Aspect Ratio Control" 
in the appendix at the end of this document. 

3 Fade With Video: When enabled, the audio will automatically fade with the video's fade-in- and 
out settings. 

Volume: Allows you to adjust the volume of the video clip with a value between 0 (muted) and 1 
(full volume).

4 Infinite Track Control
Allows you to enable or disable an infinite track for this element. This is only visible when an 
infinite track has been enabled by your system administrator in just:connect.

5 Sync Point
Allows you to set a "wish start time" where the difference to the real start time is then displayed 
in the control area. This is very useful in case you have a "prime time clip" which should start 
as accurate as possible, but you have one or several events during the day where you need the 
"Jump to Next Clip" function. Define the sync point here and every time you change something in 
the rundown, the offset of the wish start time and the real start time will be updated and shown 
right above the timecode.
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just:play User Interface

Inspector: Standard Attributes of Playlists2.17 

1
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1 Name
Here you can define the name of the selected playlist.

2 Start
While placing a playlist in the calendar view the start time is automatically defined. Change the 
start time here if needed. This option is greyed out if the start time is already in the past or 
defined automatically because the type of the playlist is not "timed" but "chained".

3 Duration
Here you can define the length of the selected playlist. This option is greyed out if the length is 
defined automatically due to the fact that the "Auto Duration" feature is enabled for this playlist.

4 Loop
Define if a playlist should be looped. Once the number of loops is defined you have to come back 
and change the setting here if you need more or less loops. In addition – when the content has 
been played once – you cannot change the content of the playlist anymore. To make changes 
again, reduce the number of playlists and copy and paste the playlists instead of looping them.

5 Type
With this setting you can define if the playlist starts at the predefined time ("timed") or if it 
automatically gets its start time from the actual end of the previous playlist ("chained"). Activating 
the type "chained" guarantees that there is no gap between this playlist and the previous playlist 
(see chapter "Playlist Chaining").

6 Auto Duration
This attribute sets the length of the playlist automatically to the total length of all QuickTime 
movies/live clips within that playlist and is automatically enabled if there is a live clip which 
has the "infinite" option turned on. Inserting or removing clips from the playlist with this option 
enabled will increase or decrease the length of the playlist, as well as the start times of any 
following chained playlists. This option is not available for empty playlists. Enabling this feature 
makes sure that there is no gap at the end of the respective playlist.
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7 Allow Resync
Your system administrator may have set up this channel to resync the master time to the reference 
time automatically. When enabled, frames will be added/deleted at the end of each playlist (if 
required). For some kind of playlists (commercial breaks) you may want to make sure that every 
frame is played out . Deactivate this option to disable the resync function for the selected playlist.

8 Color
Allows you to set a color for a playlist.

9 Shuffle Playlist
Press this button to shuffle the content of the video layer of this playlist. It is possible to use this 
function multiple times, the result will always be visible immediately in the workbench.

10 Infinite Layer Control
Your system administrator may have set up this channel to show one or several graphics 
automatically all the time. For some kind of playlists (commercial breaks) or for a single element 
in the video layer you may want to disable such a graphic element. Activate this option to disable 
the graphic element for the selected playlist or video clip.

just:play User Interface

Inspector: Graphic Specific Settings2.18 

1

3
2

4

5

1 Text Field
Text in this field can be changed at any time. It accepts all characters.

2 Checkbox
A checkbox is a boolean value (it can be unchecked or checked, "false" or "true"). In this case the 
checkbox enables or disables a certain element inside of the selected graphic.

3 Slider
A slider can be used to define a value roughly. The exact slider value is displayed in the text box 
on the right of it. This text box can also be used to modify the slider's value. A slider value has a 
minimum and maximum value.

4 Number Variable
A number value which can be positive or negative.

5 Color Value
Clicking on the colored bar opens a color picker.
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3  Creating a Schedule
Creating a Schedule

Assumptions3.1 

Make sure that the channel is ready by checking the following points. If just:out and just:connect are 
running on another machine, you can ignore the first two points:

ρρ just:out is running and the buffer status is green and fully filled.
ρρ just:connect is running and there is a green light in front of the channel you want to use.
ρρ just:play is ready on your machine and you know the channel you want to connect to (plus the 

corresponding user/password combination to connect to that channel).

Creating a Schedule

Creating a Playlist3.2 

A playlist is made up of QuickTime movies, graphic elements and events like live events or GPI/router 
control. One or several playlists define the rundown which is played through the day. Such a rundown 
may have gaps between the playlists (automatically filled with content defined in a "Default Gap Playlist"). 
The playlist handling is outlined in the following:

ρρ Create a new playlist
ρρ Fill the playlist
ρρ Modify attributes of the playlist or elements inside the playlist
ρρ Modify, move, organize and chain playlists if desired
ρρ Save playlists or even the rundown of a whole day and load them on 

another channel

Playlists are shown in the calendar view. This view has several ways to build a new playlist or add a pre 
made/saved playlist to the rundown, which will be explained in the following chapters.
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Creating a Schedule

The Calendar View3.3 

Because the calendar view is the part of the interface which gives you a proportional overview of your 
rundown, it is the place to add new playlists or delete already scheduled playlists from the channel you 
are connected to.

3

1

2

1 1-Hour Playlist
Double click an empty area inside the calendar view to create a new, empty playlist with a duration 
of 1 hour. Use "cmd + shift + double click" between two playlists to fill the whole gap automatically.

2 n-Hour Playlist
Click and drag the mouse inside the calendar view to create a playlist which increases its length 
in 15 minute steps.

3 Gap
"cmd + shift + double click" fills the whole gap between two playlists with an emtpy playlist. 

Note

After creating a playlist it will not contain any elements. When switching the user interface 
into "Editing Mode" by double clicking on a playlist, there will be a large red gap in the 
timeline indicating the remaining time of elements needed to fill the playlist completely.
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Creating a Schedule

The Calendar View – Drag & Drop3.4 

You can drag and drop single elements but also entire folders and even pre saved playlists from the 
library into the calendar view. If you drop a folder into an existing playlist in the calendar view, all 
QuickTime movies within the folder will be inserted at the end of the playlist. Note that all sub folders 
will be traversed for QuickTime movies as well (the folder structure itself will not be preserved). Instead, 
a single list will be generated consisting of all of the QuickTime movies in the dragged folder and all of 
its descendent folders. Loops and infinite live events within the dropped playlist will be ignored.

Drag and drop any combination of files and folders from the library into an empty section of the 
calendar view and a new playlist will be automatically generated with the dragged movie clips as its 
contents. This new playlist will have the "Auto Duration" feature enabled and therefore will have a length 
to fit all clips within the playlist.

Note

We recommend to have at least one playlist (which has its start point at the current day) 
scheduled in the rundown per day. Also try to avoid gaps which are longer than 24 hours.

Creating a Schedule

Adding QuickTime Movies to a Playlist3.5 

There are several ways to add QuickTime movies to a schedule. Drag one or multiple QuickTime movies 
from the library and…
ρρ …drop them into the calendar view. If there is no playlist, a playlist with the proper duration is 

automatically created with the movies you have selected. 
ρρ …drop them into a playlist in the calendar view. The movie(s) will be added at the end of the playlist.
ρρ …drop them into an existing playlist in the workbench. Before dropping the movie its position is 

indicated by a small turquoise bar which appears between existing movies.
ρρ …drop them into a playlist in the timeline. Before dropping the movie, its position is indicated by a 

small blue bar which appears between existing movies.

When the playlist is being filled with your QuickTime movies the remaining gap to the end of the current 
playlist will be displayed. You can also drag and drop files from the Finder.
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Creating a Schedule

Adding Graphic Elements to a Playlist3.6 

To add graphic elements to your schedule switch to the "Graphic" tab in the library and drop a graphic 
file on a layer in the timeline. If desired change the attributes or the duration of the graphic element by 
using the mouse (in "Editing Mode" only) or in the inspector.

Creating a Schedule

Adding a Live Event to a Playlist3.7 

In just:play you can use "Live Input" which is available under 
the "Event" tab in the library. Drag and drop the "Live Input" 
element into your rundown to create a live event which lasts 
30 seconds. Use the inspector to change the length of a live 
event. At the end of the live event the next QuickTime movies 
in your rundown will be played out automatically.

The "Live Input" video has an "Infinite Length" option that can be enabled in the inspector. When enabled, 
the clip has a pre-determined duration and an end time in the schedule but when this time is reached 
the live clip does not end automatically. Instead, just:out "holds" the live clip until you manually dismiss 
the live clip by clicking on the "Play Next"  button found above the timeline in just:play. 

Whilst being "held" by just:out, any other items excluding 
the currently playing graphic elements but including all 
video or graphic clips in the same playlist (or any following 
playlists) are also held. They will appear to "wait" at the CTI 
line displayed in just:play.

Once dismissed (by pressing the "Play Next" button), just:out will calculate the difference between the 
pre-defined scheduled duration of the live clip and the actual time played out, and just:connect will 
automatically adjust the following schedule to compensate for this difference. If the live clip has been 
on air longer than planned, then any following items and playlists will be rescheduled for a later start 
time. Conversely, if the live clip has been on air for a shorter time than planned, then any following 
items and playlists will be rescheduled for an earlier start time. Note that any "timed" playlists will also 
be rescheduled as well as any "chained" playlists. For an easy way to "refine" your rundown, use the 
"Sync Point" feature as described in the chapter "Inspector: Standard Attributes, Video & Audio". This 
will allow you to preserve the start time of a "prime time" clip.
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Creating a Schedule

Adding a Pre-Saved Playlist to an Existing Playlist3.8 

It is possible to add pre-saved playlists to a playlist already scheduled by using drag and drop. 

ρρ Drag and drop from the library to the calendar view: This will add the content at the end of the playlist.
ρρ Drag and drop directly into the workbench or the timeline: This allows you to precisely define where 

the content of the playlist is dropped.
ρρ Drag and drop directly into the workbench or the timeline while holding down the cmd-key: This 

splits the playlist at that position and generates a new playlist in between the two parts. 

You will get a warning when dropping of a playlist is not 
possible because a graphic element is played at that position.
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Creating a Schedule

Building GPI/Router Control Events3.9 

It is possible that your system administrator has already prepared events. If this is not the case or if you 
need other events please contact your system administrator.

Creating a Schedule

Adding GPI & Router Control to the Rundown3.10 

Using GPI and router control works the same way as using videos and graphics. Switch to the "Event" tab 
and drag and drop an event into the timeline to schedule it. Schedule and router events are independent 
of the elements below. You can execute a router event without the need of a live event and you can 
schedule a graphic element independent of other elements in the same layer or other layers for example. 
This allows you to control other systems independent of the real playout but also allows you to execute 
several events independent of other elements which may be executed at the same time.

We support an extensive number of routers from different vendors using different protocols. Please 
contact ToolsOnAir directly if you would like to use a router/protocol which is not supported at the mo
ment.

1 2

When the time has been reached where the event has been scheduled, all events within that event will 
be executed. This allows you to control several video routers and to send several GPI triggers at the 
same time.
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Creating a Schedule

Saving and Reusing a Playlist3.11 

To save a playlist drop it from the calendar view or the workbench into the "Playlists" tab in the 
library or select the playlist and choose "Save Playlist As…" from the "File" menu or click on the "Save 
Playlist As …" button in the inspector. Saved playlists are located at the path specified in the just:out 
preferences (the default path is: ~/Documents/Playlists). It is possible to transfer saved playlists to 
other machines and reuse them there. Doing so you have to make sure that just:out has access to all 
the files which are used in those particular playlists. 

Menu "File » Save Playlist As…"

Use the save dialog to define a name for the playlist or use 
the default name which consists of the name of the playlist 
and the date it has been scheduled. The preselected folder 
shown here depends on the playlist repository path which 
has been defined by your system administrator in the just:out 
preferences.

Reusing a Playlist

To reuse a playlist just drag and drop the playlist from the 
library into the calendar view. This will add the playlist at 
the time and day you dropped the playlist. It is also possible 
to hold the "ctrl" key, this will ignore the day and time and 
changes the playlist type to "chained".

It is also possible to save playlists in plain text (CSV) format. This is useful in case a third party system 
needs the rundown information before the playout happens and therefore the usage of the "As-Run Log" 
file is not possible.
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Creating a Schedule

Reusing a Playlist: Modifier Keys3.12 

ρρ Holding down the ctrl-key while dropping a playlist into the calendar view will ignore the position 
(time) the playlist is dropped and make the playlist automatically chained.

ρρ Holding down the alt-key while dropping a playlist into the calendar view will make the playlist 
remember the time it was scheduled originally.

ρρ Holding down the cmd-key while dropping a playlist into the calendar view will make the playlist 
remember the date and time it was scheduled originally. This is especially helpful in case the playlist 
has been made offline using a copy of just:play on another system.

Creating a Schedule

Chained and Timed Playlists3.13 

For some tasks it is required to "chain" playlists. Using chained playlists is a guarantee that there is no 
gap between two playlists. 

Whenever a new playlist is created via drag and drop or when a previously saved playlist is dragged 
from the library's "Playlists" tab to the calendar view and thus placed in the schedule, the playlist is 
automatically set to be a timed playlist (even if the saved playlist was a chained playlist). This is because 
placing a playlist in the schedule means specifying a start time which is an attribute of a timed playlist. 
You can change the playlist type to chained but this may mean that the playlist's start time is changed 
depending on the end time of the previous playlist (= the playlist's start time is changed so that the start 
time matches the end time of the playlist before). 

3

1

2

1 Timed playlist
This kind of playlist has a predefined position and is able to attach chained playlists.

2 Chained Playlists
The playlist starts whenever the playlist before ends and therefore another playlist has to be 
scheduled right before this playlist. If the end time of the playlist before changes, the start time 
of the chained playlist will adjust so that there is no gap between the two playlists.

3 Playlist Type
Select the playlist type in the inspector.
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4  Playlist Handling & Extras
Playlist Handling & Extras

Importing a Playlist4.1 

just:play allows you to import plain text playlists in any standard "delimited" format such as comma 
separated values (CSV), tab, colon, semicolon or pipe ("|") separated values.

Importing a Plain Text Playlist

To import a playlist in just:play go to the menu "File »  
Import Text (CSV) Playlist".

Within the text file one or more "columns" of data may be defined and these columns can be mapped to 
"full path", "path only" and "file only" when importing:

ρρ Full Path: Only one column of data is required which contains the complete path and filename of the 
clip to play.

ρρ Path Only/File Only: Two columns of data are required where the first defines just the path and the 
second the filename of the clip. Together these define the full path of the clip to playout, such as  
"/Volumes/./" and "Example.mov" to give the full path "/Volumes/./Example.mov".

When importing a playlist the file must conform to one of 
these two options. In addition, an optional name/description 
field may be defined in the data. If specified, the text defined 
in this column is used as the label specified in just:play's 
workbench for each clip. Finally, there is also an option to 
ignore the first row of data which is often useful if the first 
row of data in the file specifies the names of the columns 
of data rather than actual data. If any of the clips in the 
playlist are not found during the import they are listed in the 
"warnings" table. 

There is also a function which allows you to optionally specify two or more columns in your data file 
that should be combined into the "title" that is displayed in just:play's workbench.

Notes

ρρ It is possible to select the text encoding that the file is encoded in. You may select from 
ASCII, Japanese EUC, UTF-8, ISO Latin 1 (ISO/IEC 8859-1), ISO Latin 2 (ISO/IEC 8859-
2), Shift JIS, UFT-16 (Unicode), Windows Cyrillic, Windows Latin 1, Windows Latin 2, 
Windows Greek, Windows Turkish, ISO 2022 Japanese and Mac OS Roman encoding.

ρρ To import a just:out "As-Run Log" you must select "UTF-8" and not "ASCII" when 
importing the text file in just:play.

ρρ When using Apple's TextEdit to build the playlist, make sure the text file is saved in 
plain text (menu "Format » Make Plain Text").
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Playlist Handling & Extras

Importing Playlists using JavaScript4.2 

With this function you can select an XML file saved by any third party system and turn it into a just:play 
playlist. The JavaScript selected in the advanced settings of just:connect will be used as the parser. TOA 
offers such parsers for an additional fee, depending on the customers needs.

Playlist Handling & Extras

Importing Final Cut Pro 7 XML Playlists4.3 

With this function you can select any XML file saved by 
Final Cut Pro 7 (or any application that saves Final Cut Pro 
compliant XML such as Rough Cut Editor or Adobe Premiere) 
and the Final Cut Pro "sequence" will automatically be 
turned into a just:play playlist file which you can save in the 
"Playlists" repository folder. By saving it into this folder the 
file is automatically available for the corresponding interface 
client. 

You can then switch to the "Playlists" tab in the library and drag and drop the converted playlist into the 
calendar view to add the playlist to your schedule. 

The "Import Final Cut Pro XML Playlist" function supports multiple video layers. The first video layer in 
the sequence is always imported to just:play's video layer. Any further FCP video layers will be treated 
as FX layers by just:play, and any QuickTime movies included on these layers in the sequence will be 
rendered by ToolsOnAir's QuickTime Quartz patch. As such, any QuickTime movies clips on such video 
layers ought to be "full screen" (i.e. the same size as the selected video output mode specified in the 
just:out preferences) and if it includes an alpha channel (e.g. ProRes 4444) the transparency will be 
taken over. This way the movies on the FX layers will be rendered over the QuickTime movies in the 
video layer when played out by just:out. Additionally, you can also copy any Final Cut Pro XML file 
into your "Playlists" repository folder and it will appear in the "Playlists" tab in just:play's library view 
(without converting the XML to just:play's format). You can then drag and drop the playlist into the 
calendar view to add the playlist to your schedule.

Note

ρρ Final Cut Pro X playlists are also supported, but only the video layer will be taken over, 
graphic files not stored at the video layer will be ignored.
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Playlist Handling & Extras

Refreshing a Playlist4.4 

When using the "Refresh Playlists" function available in the 
menu "File » Refresh Playlists", a popup window will appear 
with two buttons:

ρρ "Refresh All Playlists": Refreshes all playlists scheduled 
for the current day.

ρρ "Refresh Selected Playlist": Refreshes the currently 
selected playlist in just:play's workbench.

The "Refresh Playlists" function checks each QuickTime movie in the playlist against the actual media 
found in the video repository folders, looking for files that have changed duration, either shorter or longer 
in duration compared to the duration stored in the playlist when the QuickTime movie was originally 
scheduled. This may be useful if QuickTime movie files have been changed in the background since they 
were scheduled in just:play. Any changes found will be automatically updated in the playlist and logged 
in the popup dialog window's log. In addition, if the playlist itself uses the "Auto Duration" function 
then any changes made to the duration of any QuickTime movies in the playlist will automatically be 
reflected in the playlist's duration.

When the "Remove any missing/deleted clips from the playlist" option is checked, any clips in the 
playlist that can no longer be found in the video repository folders will be automatically removed 
from the playlist. When not checked, any such QuickTime movies will be left unaltered in the playlist 
(meaning that black will be played out for the duration of the video clips), but you will receive a warning 
in the log window when refreshing the playlist.
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Notes

ρρ When the "Automatically refresh dropped playlists" option is selected in just:play's 
preferences, any playlist dropped from the library to the rundown will automatically be 
refreshed. In case user action is needed, the "Refresh Playlist" window will be opened 
automatically.

ρρ You can use this option also for playlists already scheduled in the rundown (to update 
the metadata information like aspect ratio and fps).

Playlist Handling & Extras

Items Deletion Rules4.5 

The rules used when determining whether or not items may be deleted are:

ρρ Past: Anything (playlist, video, graphic, event) that lies completely in the past cannot be deleted. 
ρρ Present (on air): Playlists and graphics that are currently on air may be deleted, but only after a 

warning. Videos that are on air cannot be deleted but skipped by clicking the "Play Next"  button.
ρρ Future: Anything (playlist, video, graphic, event) that lies in the future may be deleted without warning.

Playlist Handling & Extras

Offline Playlist Building4.6 

As well as the possibility to create and edit a playlist directly connected to an online channel it is also 
possible to create playlists on any other machine. 

ρρ Your system administrator may have configured an offline channel which can be used to build 
playlists without affecting a channel which is on air. Start just:play and connect to this offline channel. 
just:play is now in a state in which you can create and edit playlists without working on an active 
(online) channel. In addition you always work in "Editing Mode". 

ρρ After finalizing a playlist you can either save it directly into a watch folder of an active channel (which 
means the playlist is loaded immediately on that channel) or you can save it in a playlist repository 
folder of a channel – in this case the operator has to load the playlist on the desired position in 
playout.

ρρ Make sure that the time where the new playlist is scheduled is unused on your master playout. If 
a single frame is already scheduled, the whole playlist will be rejected and therefore not be played 
out. Keep in mind that only TOA XML compliant playlists can be dropped into a watch folder, other 
formats will be ignored.

Read the chapter "Saving and Reusing a Playlist" for more information about saving a playlist and ask 
your system administrator if such watch folders do exist for the particular channel(s).
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5  Graphic Elements
just:play supports "Quartz Compositions" (file ending "qtz"), "Composition Builder Compositions" (file 
ending "composition"), "ToolsOnAir Graphics Engine Compositions" (file ending "jscomposition"), JPEG 
and PNG files. Quartz Composer and Composition Builder files are handled differently by just:play.

Quartz Compositions
ρρ Initial duration of 30 seconds (adjustable in the inspector or in the "TOA 

Stopframes" patch)
ρρ No stopframes (unless "TOA Stopframes" patch is used)
ρρ Published input ports are shown in the inspector
ρρ Thumbnail from a random frame of the composition (unless thumbnail is 

specified)

Illegal Quartz Composer Patches

Not all Quartz Composer patches are supported by the 
just:out rendering engine, particularly the "JavaScript" patch. 
If a Quartz Composer or Composition Builder composition 
with such a patch is dropped into a playlist, a warning will be 
displayed.

Thumbnails for Quartz Compositions

It is possible to specify a thumbnail image for a Quartz file. 
Save a JPEG image in the same folder like the Quartz file and 
supply the file name with the ".thumb" extension instead of 
the ".jpg" extension. 

Example: Save an image with the name "Example.thumb" for 
a Quartz Composition named "Example.qtz" . For best results 
the thumbnail image should be 355x199 pixels.

Make sure that the extension of the file is set correctly. 
Sometimes it is not sufficient if you just replace ".jpg" by 
".thumb" in the Finder. The "Info" window of a file could still 
display the file name as "myfile.thumb.jpg". If so, remove the 
".jpg" extension.

Notes

ρρ Not every Quartz Composition works with just:play. ToolsOnAir provides no support 
for custom QTZ Plug-Ins/patches. Please contact ToolsOnAir if you need customized 
graphics development.



address Zirkusgasse 39 | A-1020 Vienna | Austria | phone +43 (0) 1 236 8665 | mail info@toolsonair.com | website www.toolsonair.com 35tools ‡ air

Composition Builder Compositions
ρρ Duration as set in the composition
ρρ Stopframes as defined in the composition
ρρ Published input ports are shown in the inspector according to the given 

permissions in the composition
ρρ Thumbnail loaded from the composition package

ToolsOnAir Graphics Engine Compositions
ρρ Duration adjustable in the inspector
ρρ Partial stopframe support
ρρ Published input ports are shown in the inspector

JPEG and PNG Images
ρρ Drag and drop directly into the workbench
ρρ Automatic stretching of the pixel size of the image to cover the full output 

frame
ρρ It is recommended that you only use images that are properly sized for 

whatever output display mode has been selected defined for that particular 
channel

Using QuickTime Movie Files on FX Layers
ρρ Drag and drop directly into the workbench while holding down the command 

key
ρρ Automatic stretching of the movie to cover the full output frame, therefore it is 

recommended that you only use movies that are properly sized for whatever 
output display mode has been defined

ρρ Drag and drop of QuickTime movies from the library to a FX layer on the 
timeline or workbench displays a movie as if it was a "graphic", meaning that 
it will be displayed over any QuickTime movie playing on the video layer. As 
such, it makes sense to drop QuickTime movies containing an alpha channel 
into a FX layer (we recommend to use Apple ProRes 4444 movies). When a 
QuickTime movie is used as a graphic it is not possible to set an in- or out-
point
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6  ToolsOnAir Helpdesk
Administrators and users are able to use the ToolsOnAir 
online helpdesk. The helpdesk provides frequently 
asked questions, current software installations and 
more supplemental documents like user manuals and 
data sheets. You can also report bugs or submit feature 
requests to our developers and engineers.

http://support.toolsonair.com/

7  Known Issues
(1) Using a "Contour ShuttlePRO" changes the UI

When using the shuttle wheel of a "Contour ShuttlePRO" device for previewing a file in just:play's UI and 
the mouse cursor is above the workbench or above a timeline, the OS interprets the shuttle movement 
as a scrolling wheel and therefore moves the scrollbar and/or changes the scaling of the timeline.

(2) Using a channel with more than one video layer

When using a channel with more than one video layer make sure that any live event is only scheduled 
in the first (lowest) video layer. Scheduling live events in another video layer can result in unexpected 
behavior.

(3) Using an offline channel with event items

Independent of the capabilities of the master channel, it is possible to add any kind of router/GPI events 
to a playlist when using an offline channel. Therefore it is possible to schedule events which will not be 
executed by the master playout, because the license to play such events has not been purchased for 
the master play out.
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8  Appendix
Appendix

Aspect Ratio Control8.1 

just:out provides a comprehensive aspect ratio control. The following illustrations may help you to 
understand the different options.

Playing 4:3 material in 16:9

Playing 16:9 material in 16:9

Playing 16:9 material in 4:3

Playing 4:3 material in 4:3

Pillar Box

Scale

Full Frame

V-Stretch

Full Frame

Letterbox

Scale

H-Stretch

Play 16:9

H-Stretch

Scale

H-Squeeze to Pillarbox

V-Stretch

Play 4:3

V-Stretch

Scale

V-Squeeze to Pillarbox

H-Stretch
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